front
March 2002

The Magazine of Choice for Plastics Professionals

case studies

Viscount Plastics
Swift Technologies
industry education

BIMS Seminars Take a Non-Traditional Approach
Working Smarter with Web-Based Training
Penn State Erie — The Impact Players of Tomorrow
www.moldflow.com
Vol. 2, Issue 1 2002

© 2001 Parametric Technology Corporation. All rights reserved. PTC, Pro/ENGINEER and
the PTC logo are trademarks or registered trademarks of Parametric Technology Corporation.

Art to Part at Breakneck Speed

Pro/ENGINEER® MoldShop™: Engineered for Innovation in the Mold Industry
It was said that it couldn't be done: Start from nothing,
end with a molded part, finish in a day.
Yet, at NPE 2000, this was done not once, but five times.
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molds, thousands of injected parts produced, live on the show
floor. The software of choice, and the only software needed for
the “Mold-in-a-Day” RUSH Technology team: Pro/ENGINEER®.

Pro/ENGINEER is the only choice to tackle the whole job, taking
industrial design concepts to completed toolpaths with no
translations, while permitting last-minute no-penalty changes.
Art to part at breakneck speed.
To learn more about how you can significantly improve your time
to market visit www.ptc.com/products/function/tool_die.htm or
keyword search rush.
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from the editor
Finally! Refreshing news
Recently, I attended the Daratech Summit 2002 conference in New York City. It was well
attended by technology leaders who now tout product lifecycle management (PLM) products and
strategies. Whether you buy into this latest buzzword or not, I came away feeling much more
confident about the state of our industry and the state of our economy. The reason? Presentations,
in particular, by Bernard Charlès of Dassault Systemes, Carol Bartz of Autodesk, and Tony Affuso
of EDS. They gave positive, uplifting commentaries about industry growth, profits, and new
technologies that are helping to spur their businesses, and, more importantly, provide customers
with innovative solutions to develop new products at record-breaking speed while reducing manufacturing costs and
expensive prototypes. This is extraordinary good news for everyone served by these companies, their suppliers, and partners.
While the worldwide technology marketplace has experienced a rough road over the last 18 months, these three industry
leaders envision a brighter future for everyone as we move forward into 2002 and beyond. In addition, Mark Goldstein,
president and CEO of HKS, developer of worldclass ABAQUS CAE software and a Moldflow partner, announced his
resolve at Daratech Summit 2002 to "take the wraps off" the company's quiet history. He provided statistics that showed
stellar growth since the company's 1978 inception, as well as its recent news to partner with LMS and Dassault Systemes.
More collaboration among vendors can only make the user workplace a friendlier, easier-to-innovate environment.
Even though Moldflow was not part of the Daratech Summit 2002 event, its latest news is just as encouraging. Company
president and CEO Marc Dulude recently reported that the company's financial results for the second quarter of fiscal 2002
were encouraging. He said, "We entered this quarter with good visibility into our business and were able to close a high
percentage of our sales opportunities. We were particularly pleased with the order flow for our Manufacturing Solutions
products, which comprised 17% of our software product revenues this quarter. These products, which yield significant and
rapid returns, present a compelling value proposition to injection molders who are seeking strategic advantages to remain
competitive during this time of economic uncertainty."
In addition, this week financial guru Alan Greenspan announced that the global economy is beginning to turn around. I
must believe that these technological and financial events and others to come will help our industry start to climb back to
market profitability, calmer, more confident investors, and a bullish Wall Street. And, while it may be a little too early to
toast to a new economy, I am confident that we can all rest easier, anticipate a brighter future, and confidently begin to
consider reinvesting in profitable companies. We salute development and management teams everywhere that are
committed to generating new products that exceed customer expectations as the economy moves back to a more stable,
energetic state.
Certainly, Moldflow is taking the lead among leading software providers. This issue reveals how the company is offering
innovative training and certification classes to help users become more productive and marketable. We describe the
company's newest technologies, as well as detail customer testimonials as more competitive enterprises as a result of
implementing the company's software. In addition, we believe in education - teaching university students the merits of
using state of the art plastic simulation software as it relates to real-world applications before they enter the workplace. Case
in point: we think you'll be impressed reading how Penn State University is using Moldflow technology in the classroom as
an integral teaching tool. Students there are enthusiastic users who are realizing that the software will help them secure
promising jobs that build upon lessons learned in the classroom.
Again, please send us your Moldflow software tips and techniques, questions, comments, and offers to act as customer
testimonials. Send them to me at laura_carrabine@moldflow.com. I look forward to meeting with you at the 2002
International Moldflow User Group Conference as this issue unfolds.
Best Regards,

Laura Carrabine
Editor
F l o w f r o n t Vo l . 2 I s s u e 1
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Introducing Moldflow Plastics
Advisers 6.0
By Murali Anna-Reddy, Moldflow Corporation
Suggest Product
Enhancements

Introduction
Since its launch in 1997, the Moldflow
Plastics Advisers™ product line has
revolutionized the way that designers
check their plastic part designs for
manufacturability. The upcoming release
of Moldflow Plastics Advisers 6.0 (MPA™
6.0) provides users with significant new
features
and
enhancements
for
collaborating with other users, providing
product usage feedback in order to partner
more closely with Moldflow, and
increasing productivity. As part of
Moldflow's commitment to provide
ongoing value to the existing MPA
customer base, most of the new features in
MPA 6.0 are a direct result of customer
enhancement requests.
This article describes in detail new MPA
6.0 features and enhancements, including:
❒ Moldflow Community Center —
a suite of Web-centric tools that
foster interaction with other MPA
users and Moldflow Corporation.
❒ Automated Product Usage Feedback
— an automatic method for
submitting valuable product usage
information to Moldflow to aid in
creating better products.
❒ Gate Optimization Analysis —
used to determine optimized gate
dimensions.
❒ Automated gate design advice.
❒ Modeling tools and results
visualization enhancements —
including expanded automatic runner
generation and geometry mirror
capabilities, as well as a powerful
results comparison feature.
❒ Enhanced CAD interfaces — MPA
6.0 supports Moldflow Design Link
3.0, which allows the direct import
of native Pro/ENGINEER® part files,
as well as Parasolid, STEP and IGES
file formats.
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MPA 6.0 users can have a say in
future
Moldflow
software
development
by
submitting
enhancement requests to help us
drive future product development.
Frequently Asked Questions
(FAQ's), Known Bugs List,
Hints & Tips

Moldflow Community
Center
The driving philosophy behind the new
Moldflow Community Center is that a
“whole product” implemented by the user
is more than just a box of software. Just as
important are elements such as service and
support, market and industry education,
product education, strategic partners, and
a sense of community in which people
work together to solve a common
problem. Guided by this philosophy, the
Moldflow Community Center has been
developed to host a set of Web-centric
tools that foster interaction and
collaboration among MPA users and with
Moldflow
Corporation.
Active
maintenance users can access the
Moldflow Community Center directly
from within MPA 6.0 using embedded
Web browser technology. The following
tools are available at the Moldflow
Community Center:

Stay up-to-date by reviewing FAQ's
and the Known Bugs List. Also,
become more productive by reading
hints and tips posted by Moldflow
support engineers and fellow users.
Direct Access to Knowledge Zone

Moldflow's Knowledge Zone is a vast
information warehouse containing a
wealth of knowledge on an array of topics
from plastics product conceptual design to
manufacturing. Tap into the Knowledge
Zone content by linking to its Web site or
perform a search to navigate directly to the
topic of interest.
Product Revision Download

This feature allows users to access the most
recent patch releases, ensuring they are
using the latest technology.

Discussion Group

Communicate with other MPA users,
exchange ideas and tips, discuss issues, ask
questions, and obtain answers. The
discussion group facilitates a mechanism
for users to gather collective knowledge
and solve common problems.
Report Product Issues

MPA 6.0 streamlines the process of issue
reporting by allowing users to report issues
directly from within the product. A
Moldflow customer support engineer will
review the issue, take appropriate action,
and update the customer on the problemsolving status.

F l o w f r o n t Vo l . 2 I s s u e 1

Access Training Resources

View all training resources available for
your Moldflow products and sign up for
upcoming training sessions. Training
elevates users to become more productive
and maximizes their return on investment
in Moldflow software.
File Exchange Area

This is a common file storage/download
area for useful files such as common
runner layouts, standard runner sizes, etc.
w w w. m o l d f l o w. c o m

News Flash

The news flash relays important and timesensitive information about MPA, the
Moldflow Community Center, and any
relevant current events.

mold makers today. To help alleviate this
problem, two powerful tools are
introduced in MPA 6.0. The first of these
tools is the ability to run an automatic
gate sizing analysis, which estimates the

It is increasingly more important to stay well
connected with our customers to ensure that we
are developing technology that adds value to
our customers’ processes.
Automated Product
Performance and Usage
Logging
Moldflow has kept abreast of customer
expectations through a variety of methods
including user surveys and user group
meetings to ensure that we are developing
technology that adds value to our
customers' processes. We realize that one
of the keys to meeting our customers'
expectations and developing better
products lies in the continuous
monitoring and analysis of product
performance and product usage.

Gate Design Optimization
Tools
Troubleshooting and optimizing the gate
design remain key challenges for many
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model gates that are part of an ejector pin
or an insert. The trapezoidal gate allows
for easier modeling of typical edge, fan,
and tab gates.

best gate dimensions and automatically
updates the model with the calculated
dimensions. Automating the process of
optimizing gate dimensions means mold
designers have one less aspect to worry
about in their mold design.
The second optimization tool is the
automated gate design advice, which
removes the guesswork involved in
troubleshooting gate-related problems.
Users are provided with gate-specific
advice, allowing them to drill down at
each gate and obtain specific advice on
troubleshooting and solving gate design
problems.

With that in mind, MPA 6.0 is configured
to log product performance and product
usage information and automatically send
that
information
to
Moldflow
Corporation periodically. Information
collected in these logs will allow us to
investigate product usage patterns and
identify areas for product improvements.
Ultimately, this process will provide an
opportunity for MPA users to more
actively partner with Moldflow and help
us create better products to meet their
needs.
The product usage information will be
automatically logged and uploaded to
Moldflow Corporation through a secure
FTP connection. It is important to note
that no proprietary information is
gathered in this process, nor will the data
be shared with anyone outside of
Moldflow Corporation.

Focus
on

Moldflow Mold Adviser
Modeling Enhancements
From a geometry model standpoint, a
major focus of MPA 6.0 is to introduce
several enhancements in Moldflow Mold
Adviser that can drastically reduce the
time spent in modeling, resulting in
significant productivity gains.
In increasing the number of gate types
supported, two new gate cross sections —
half-round and trapezoidal — have been
added to the database of available gate
types. The half-round gate can be used to

Within MPA 6.0, it is possible to perform
an analysis with only the gate(s) attached
to a part cavity model. This is extremely
useful when several gate design analysis
iterations are planned and analyzing a
complete multi-cavity layout with the feed
system attached would be time
consuming. Once an optimized gate
design is determined, the sprue and the
runners can be added easily to complete
the feed system.
With MPA 6.0, users can automatically
create runners in three-plate molds, which
eliminates the tedious task of manually
creating runners for standard three-plate
mold layouts. Another useful modeling
enhancement is the facility to create a
mirror copy of a part cavity model. With
this feature, MPA users no longer need to
depend on their CAD system for
importing mirrored components, and
therefore, separate CAD models for
analysis purposes. The ability to easily edit
runner system lengths makes it easy for
users to decrease modeling time and reuse
previously created runner system layouts.
Finally, it is also possible for Moldflow
Mold Adviser users to create a library of
standard geometric sizes for use when
modeling sprues, runners, and gates.

Results Comparison Tools
MPA 6.0 includes a powerful results
comparison utility for simultaneously
comparing analysis results from two or

w w w. m o l d f l o w. c o m
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more models. Users simply open two (or
more) models with results, then
synchronize the window displays and the
results plot scales. Users can then
simultaneously investigate the models and
results. This feature helps users to better
interpret results and quickly identify
optimized combinations of part geometry,
material selection, gate locations, and
processing conditions.

Enhancements to the Report Wizard focus
on increasing the efficiency of the report
creation process and the effectiveness of
the reports created. Users can now create
reports that include results from several
analyses. In addition, reports can be
customized in many different ways,
including turning on/off features,
selecting view bookmarks, adjusting image
sizes, choosing font size, and arranging the
order of results.
MPA users who wish to perform more indepth analyses can export their data using
the Moldflow Plastics Insight 3.0 (MPI
3.0) study file format. All pertinent
model, material, and analysis information
will be exported from MPA, eliminating
the need for redundant actions in the MPI
3.0 environment.

The Sentinel License Manager, from
Rainbow Technologies, replaces Elan as
the License Manager for MPA 6.0. New
license keys are required to use MPA 6.0
and can be obtained by completing the
product registration. A new Commuter
License feature is available in Sentinel,
which allows users to check out a license
from a license server for up to 30 days, and
use the license remotely, such as on a
laptop computer. This feature is available
only on PC systems and does require a
floating license.

Update on Supported
Hardware

Enhanced CAD Interfaces
and CAD Integrations
Moldflow Design Link 3.0 (MDL 3.0) is
completely integrated with MPA 6.0.
Moldflow Design Link 3.0 provides a
geometry data translation interface
between Moldflow Plastics Advisers and
leading CAD systems using standard file
formats such as IGES, STEP, and
Parasolid, as well as allowing direct import
of native Pro/ENGINEER® part files.

New License Manager

Analyses can be set up using logical
sequences to eliminate the need for
manually launching individual analyses.
For example, a Plastic Flow + Sink Mark +
Cooling Quality Analysis sequence would
launch the three analyses sequentially
without any additional user intervention.

The MPA CAD-integrated versions have
been updated to support the latest product
releases from the world's leading CAD
companies,
including
SolidWorks
2001Plus, Solid Edge 11.0, SolidDesigner
2001, and Mechanical Desktop 6.0. Also,
new in MPA 6.0 is an integration with
Autodesk Inventor 5.0.

PC users can now choose either Intel or
AMD processors, as support of the AMD
Athlon processor has been added. Also
new is support of Microsoft's Windows
XP operating system.
The complete list of officially supported
hardware platforms and operating systems
includes Microsoft Windows 2000,
Windows ME, Windows XP and
Windows NT, Sun Solaris 2.8, HP-UX
11.0, SGI Irix 6.5, and IBM AIX 4.3.5.

Conclusion
MPA 6.0 contains significant new features
and enhancements for increasing
productivity, collaborating with other
users, and providing product usage
feedback in order to partner more closely
with Moldflow.

Other Key Enhancements
The material database has been redesigned
with an emphasis on ease of use.
Commonly used materials are saved to a
separate list to expedite material selection.
Search criteria can be customized to search
by virtually every material property in the
database. Lastly, viscosity, PVT, and other
relevant material data can be quickly and
easily plotted.
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MPA 6.0 also includes a new, compressed
common file format for both Moldflow
Part Adviser and Moldflow Mold Adviser,
reducing disk space storage requirements.

For the latest information on Moldflow
Plastics Advisers and all of Moldflow's
product and services, visit our Web site
www.moldflow.com.

w w w. m o l d f l o w. c o m

user review
Early Analysis Reduces Lead Times for
Sydney Olympics Athletes' Beds
By Laura Carrabine, Editor

Background
Dunlop Bedding, a division of Pacific Dunlop and the largest
Australian manufacturer of beds, was the provider of 24,000 beds
that made their debut at the Sydney 2000 Olympic Games
athletes' village. These "bunkable" beds were designed for use as
single beds or stacked to form bunks, with the option of extending
the length of the beds by 300mm for use by the taller athletes. In
addition to meeting the functional and structural requirements,
Dunlop Bedding was also looking for a fresh, modern shape and
color. Dunlop Bedding decided to manufacture the bed frames in
powder-coated steel and the bedhead panels in translucent plastic
with a choice of several bright colors.
Viscount Plastics is a member of the Pacifica Group and the
largest injection molding company in Australia. Viscount Plastics
(Victoria) was chosen by Dunlop Bedding to project manage the
design and manufacture of tooling and to produce 48,000
bedhead panels for these beds. Viscount recommended
polypropylene homopolymer as the material for the bedhead
panels, as it met the requirements for safety, aesthetics, low
weight, low maintenance, ease of assembly, and cost effectiveness.

The Project
As the translucent bedhead panel is a highly visual part, a critical
requirement was that there could be no visible defects or warpage.
"We have utilized the analysis expertise of Moldflow's consultants
for a number of years now, with filling, cooling, and warpage
analyses being important tools in the part and mold design phases.
We decided that the ability to verify and optimize tool and
product designs early in this project should help us to reduce lead
time to manufacture, avoid start up problems, and reduce reject
rates," said Mr. Vadim Gershon, Product Development Manager,
Viscount Plastics. In this
project,
Moldflow's
consultants
were
employed at the product
design stage in order to
optimize the part and tool
design and to verify cycle
time and processing
conditions. "We wanted to
ensure that we could
reduce lead times of the
first acceptable samples, so
that Dunlop Bedding
would have enough time
to tune the other
components to fit the
bedhead (if necessary),
and supply beds in time
for the Olympic Games,"
said Mr. Gershon.
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Moldflow Part Adviser software was used to verify the gate design
and location suggested by Viscount and to assess the fill pattern.
"The Part Adviser analysis confirmed that the area of the part at
the end of the longest flow path would fill for the proposed cavity
layout and wall thickness with the choice of polymer and gate
location," said Mr. Derek Hain, Senior Consultant, Moldflow.
The original design of the bedhead called for a three-piece
assembly. Viscount's engineering team suggested the use of sliding
cores driven by hydraulic cylinders, which would allow a onepiece bedhead panel to be manufactured. Several iterative analyses
were undertaken, and it
was found that the panels
could be produced as a
single part instead of three
separate components.
Further analyses using
Moldflow’s
MPI/Flow,
MPI/Cool and MPI/Warp
were undertaken to verify
cycle times and to ensure
the design specifications
for dimensional tolerance,
aesthetics, and negligible
warpage were met.
"MPI/Cool was used to
verify and optimize
cooling line layouts and
confirm
that
the
processing
conditions
suggested by Viscount
Plastics could be used," Mr. Hain said.
The results from MPI/Warp indicated that there would be very
little warpage, as the fill pattern and the cooling lines had been
optimized by then. "The predicted warpage was negligible and
could be further reduced with fine tuning of the injection
molding machine settings and tool temperatures during
manufacture," Mr. Hain added.

The Outcome
The initial mold trials showed that the actual cycle time was very
close to that predicted by Moldflow's software, and the parts
produced had met design specifications. "Preliminary work
conducted jointly by Viscount's engineering team and Moldflow,
as well as excellent toolmaking by Centre Tooling, has allowed us
to achieve a near-perfect part at the very first die trial. We have
probably saved at least one tool rework and subsequent die trial,
which could have cost us several thousand dollars and increased
lead time by up to 20 percent," said Mr. Gershon.

w w w. m o l d f l o w. c o m
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tips & techniques

Work Smarter with Moldflow Plastics
Insight 3.0
By Matthew Jaworski, Moldflow Corporation

We want to help you work smarter and get up to speed faster with your Moldflow Plastics Insight (MPI) 3.0 software. Here are
three tips that will help you streamline your modeling tasks and transition quickly from previous versions of the software.
Find a complete list of Hints & Tips as well as answers to Frequently Asked Questions and other valuable information on the
Customer Resource Center (CRC) at www.moldflow.com.

Did you know?
The default colors of MPI 3.0 beam elements have
specific meanings.
Red

->

Hot Runner

Green

->

Cold Runner

Blue

->

Cooling Channel

Yellow

->

Baffle

Orange ->

Bubbler

Beige

Connector Hose

->

tips continued on next page

Stop by and visit AMD at the

Moldflow 2002
International User Conference
March 17-19, in Boston, MA.

tips & techniques
Fixing Overlapping Elements
Import a model into MPI/Synergy, then select Mesh > Mesh
Statistics. Look under Intersection Details for
information about Element Intersections and Fully
Overlapping Elements. These are defects in the mesh that
you will need to fix before running an analysis.
Select Mesh > Mesh Tools to access tools that will help
you fix the defects. First, try the Auto fix tool, which
automatically tries to fix overlaps and intersections. Don't
worry about the result, because the tool reports Aspect
Ratio before and after - this will change only if the fixed
defect happens to be related to the minimum or maximum
aspect ratio. Check Mesh Statistics again to see if Auto
fix solved your element problems.

the select icon
to select the element and clicking the
Delete key on the keyboard.
TIP: To speed up the mesh editing process, turn the mesh
diagnostics window off before using any Mesh Tools or
deleting elements. To do this, select Mesh > Show
Diagnostic or click in the MPI/Synergy graphics window
and click Ctrl + D. After the editing action is complete, you
can turn the diagnostic window on again by repeating the
process.

If Auto fix did not fix all the defects, go back to Mesh
Tools and select Global Merge. This tool merges nodes
within a specified tolerance. Be careful if you leave the
Preserve Fusion checkbox option blank! When checked
(turned on), this option prevents nodes from being merged
if this would result in the removal of a side of a triangle.
Your next option is to display the overlapping elements and
manually fix the mesh. To display these elements, select
Mesh > Overlapping Elements. On the dialog that
appears, you can select to display Overlaps, Intersections
or both. Be sure to check the Place Results in Diagnostic
Layer option.

Another common way to fix overlaps is to merge nodes.
This is also accomplished using the Mesh Tools menu.
Simply select the node you want to merge to and then the
node you want to be merged.

Deselect all layers, so that only the Diagnostic Results
layer is visible. Clicking on the Diagnostic Results layer to
highlight it, then select the Expand button. The Expand
button grows the mesh around the highlighted layer by a
user-defined level, in this case one. This feature is very
useful to see what elements need to be fixed and the area
around them.

Use Mesh Tools > Purge Nodes to clean up any
disconnected nodes that may have been created during the
cleanup operations.
Next zoom in on one particular area and use the center icon
to center the view for ease of rotation.
There are many ways to fix overlaps and intersections. In
this example, the problem element is protruding through
other mesh elements at a corner. We can select and delete
this element using Mesh Tools > Delete or simply by using
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Finally, review the Mesh Statistics to make sure the mesh
is defect free.

w w w. m o l d f l o w. c o m
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professional development
Dr. Vito Leo Successfully Launches
BIMS-Seminars (Brussels Injection Molding Sessions)
By Laura Carrabine, Editor
In March 2000, Professor Vito Leo, Ph.D. (Brussels, Belgium),
established the Brussels Injection Molding Sessions (BIMSSeminars) business. BIMS-Seminars provides seminars based on
Leo's 20+ years' experience in the injection molding and plastics
industry and what he says is a real need for non-traditional
training. His seminar called "Understanding Injection Molding of
Thermoplastics — The Key to Optimum Plastics Part Design,"
provides an explanation of the mechanics and physics behind
plastic injection molding processes. Leo is a physicist by training
and has extensive experience in polymer processing. He is
particularly active in the field of injection molding of
thermoplastics and the use of thermoplastic finite-element
numerical simulation.
"During my career at Solvay as
a Principal Scientist at the
Brussels-based company," says
Leo, "I realized that there was a
real need for a seminar that
thoroughly explains some very
complex phenomenon in fairly
simple terms. People are
extremely
interested
in
attending this kind of seminar.
It's not traditional injection
molding training. It's not flow
analysis training. It's not pure
theory. I really try to fill a gap.
People have real problems every
day. How do they solve them?
For many, it's been years since
they graduated from their
university. They may know a little bit about plastics, or they may
know a lot. However, they don't have time to investigate rheology
details and thermodynamics of polymers, crystallization and other
complex issues."
"For me, there are clearly two very separate worlds when it comes
to plastics professionals — those who make products but don't
know physics fundamentals, and those who work in institutes or
universities who are very interested in fundamental work or
equations but don't know much about real life and real problems
in injection molding. So, my material fits between these two
entities," adds Leo.
As a result of this unique approach, Dr. Leo has attracted a diverse
range of seminar attendees in the nearly two years he's been in
business. The seminars generally attract engineers, designers, and
shop floor operators. However, university students and professors
attend them as well. "They all seem to take added value back to
their workplaces after a seminar," says Leo.
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Each two-day BIMS-Seminar includes the use of Moldflow
Plastics Insight (MPI) software to show MPI/Flow, MPI/Cool,
MPI/Shrink, and MPI/Warp. "I always envisioned Moldflow as
part of the seminar because of its valued use over the years at
Solvay," notes Leo. "The software is very useful to understand the
process and the complex physics behind the analysis even though
the accuracy of some predictions is not always perfect. It's an
extremely useful tool to assess, for instance, the relative
importance of various contributions in the warpage trend you
predict with a given part."
Upon initiating his seminar business, Leo agreed not to use any
Solvay resources or provide any proprietary Solvay information as
part of any BIMS seminar.
He relies on MPI software
to build examples to
illustrate the ideas discussed
at the seminar. To make sure
attendees get useful practical
information, he asks known
Moldflow
consultants
(NKT
Research
in
Denmark and Promold in
France) to conduct an
evening session based on
case stories at the end of the
first training day.
The BIMS-Seminars offer a
complete description of the
physics behind injection
molding. "I try to very
clearly show the relationship between material structure and the
problems users can encounter in injection molding. The seminar
includes extensive descriptions of amorphous, crystalline, filled
and unfilled materials. In addition, I try to show how different
these four classes of materials can behave with respect to filling,
packing, shrinkage and warpage. The very different behavior of
glass-fiber-filled polymers compared to unfilled plastics is striking.
Understanding the physics of these composite materials is the only
way to design good parts and optimize the molding process," adds
Leo.
He started his business with a private seminar at Nokia in Finland
where 30 attended — 20 designers and some of their
subcontractors such as molders. Leo noted, "There was a lot of
positive response as a result of that session. Some attendees said it
was the best seminar they ever attended in the field of injection
molding."
BIMS completed six seminars in 2000 and seven in 2001. Many
were held in Scandinavia because of the strong mobile-phone
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industry interest and the training strategy as a whole in the
northern European countries. A Danish institute agreed to
organize BIMS-Seminars and booked five events in Denmark so
far. BIMS-Seminars also organized two public seminars in Brussels
and Paris, and the first Italian seminar is scheduled for Spring
2002. Overall, about 210 people have attended the seminars so
far.
Leo uses Moldflow during his seminars, not because he is trying
to sell the product, but because it's an extension of what he is
trying to explain. "It's important to understand the assumptions
on which any software package is based," says Leo. "A lot of the
commentary during the seminar is about the physics behind the
present state of the art in simulation and why, under certain
circumstances, its capabilities may be limited. MPI is definitely
helpful."

to develop parts with better, more cost-effective designs at a faster
rate. And with the right training, Moldflow is a perfect way to do
just that."
While the seminars are a completely separate business from his
work at Solvay, Leo says that the sessions work in favor of the
plastics business as a whole. "I am just trying to increase the level
of understanding of the process that I believe can only benefit the
industry as a whole. Concurrent engineering will prevail when all
the involved parties speak the same language and share a common
knowledge base."
For more information about BIMS-Seminars, to view a
complete list of customers to date, or to arrange a session, visit
www.bims-seminars.com.

Leo says that he promotes extremely useful tools. He adds, "As
soon as you can understand the trends, and trace the physics as to
why you are experiencing a particular problem, then Moldflow
will be extremely useful. However, you need to understand the
fundamentals first."

As a result of the seminars at Nokia, Ericsson, and Bang &
Olufsen, Leo says that designers have a much better understanding
of the process. Flow analysts in these companies are using
Moldflow much more effectively. He says, "Since the seminar at
Ericsson, the company purchased a Moldflow license. I can't claim
that's because of my seminar. However, I am pretty convinced that
my contribution must have been important because they came
away from the seminar feeling that even though the software isn't
perfect, it will be very useful if you understand what you're
doing."
Apparently, people from all over Europe are happy to find all this
information within a single framework of one seminar presented
in a consistent way. Leo says the enthusiasm for more seminars in
more locations is growing despite a tight worldwide economy.
"As companies strive to work smarter in a challenging economic
environment, they realize that doing better quality work up front
is very important," adds Leo. "Taking a serious approach to
conducting simulation relates to reducing costs. Error-riddled and
expensive prototypes can be eliminated. I have first-hand
experience with this phenomenon at Solvay using Moldflow."
"Recently, we experienced a slow-down in sales due to the general
economic trend. However, during that same timeframe, we had a
strong increase in Moldflow simulation requests. So even though
sales are lagging, people are busy preparing for the future, trying
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He relates that when he trained the staffers at a large Finnish
company, some of those in attendance claimed they didn't really
want to understand the software. They just wanted the software to
do the work for them. "That is exactly what I am fighting against,"
adds Leo. "The point I try to make is that you don't need to have
a Ph.D. to understand the physics. But you might need someone
who has a Ph.D. to explain it to you. That's what these seminars
and I are all about."

F L A S H
The first edition of Flowfront was a big hit at
the Office of Continuing Engineering
Education at the University of Chicago at
Urbana-Champaign.
Professor
Jonathan
Dantzig of the Department of Mechanical and
Industrial Engineering will be using Flowfront
as part of his teaching materials. Notably,
Professor Dantzig will use information in the
first edition for teaching engineering students
in his class called "Modeling in Materials
Processing," Mechanical Engineering 351,
which began in the fall semester of 2001 and
continues through the spring semester of
2004.
At the school, engineering course lectures and
course materials such as lecture notes,
assigned readings, and handouts are made
available to registered University of Chicago
students over the Internet. The school will be
making Flowfront available to students as a
reference to the lead story "Introducing
Moldflow Plastics Insight 3.0.”
This
unique
approach
to
providing
engineering students with valuable, real world
information about state-of-the-art technology
will help students gain insight to how
innovative
software
products
and
methodologies are being used in product
development today. This is a great example of
how partnering industry with academia can
enrich learning and strengthen undergraduate
skills as preparation for real-world application
of their knowledge and attaining excellent
positions after graduation.
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Working Smarter with Web-Based Training
By Stephen Thompson, Moldflow Corporation
A changing global economy has created new business cycles that
are demanding rapid action and increasingly efficient operations,
requiring new business fundamentals and changing the way
companies function and conduct business. These new business
fundamentals require that employees rapidly acquire new skill sets
as the demand for trained professionals increases.
Even for the most experienced plastics professional, keeping
current on the latest technology can be a challenge. To remain
competitive and succeed, proper and ongoing training is essential.
Yet in today's business climate, organizations face the difficult task
of providing the necessary training amid the corporate calls for
tighter budgets, hiring freezes, and doing more with fewer
resources.
Given these parameters, Web-based training (WBT) has become
an increasingly popular new trend over the past several years. In
the simplest sense, WBT is the use of Internet technologies to
deliver training online. Recipients can receive training on a 24/7
basis through browser access to the Internet, an extranet, or an
intranet Web site, similar to common Web browsing activities.
This innovative delivery method provides high-speed access to
training content at the user's convenience and at the user's locale,
eliminating the need for travel and time away from work. These
self-paced, Web-based courses are accessible anytime and
anywhere through the Internet. By providing a cohesive, virtual
training environment, companies can overcome production
downtime, temporary loss of resources, and travel costs.
When properly implemented, WBT utilizes the immediacy,
flexibility, and richness of the medium to deliver a learning
environment that complements traditional classroom and "hard
copy" delivery methods. Utilized as a foundation, WBT can even
improve the overall effectiveness of instructor-led delivery
instruction. Students can enroll in preliminary WBT courses, for
instance, to prepare for an advanced, instructor-led class. In
addition, WBT offers extremely powerful and compelling
advantages for training employees in different locations. Global
companies may have users working at differing levels of expertise,
on a variety of products, in multiple areas of the world. WBT is
ideally suited to address this type of worker training diversity.
At the Moldflow Center for Professional Development, we realized
that our global customer base is benefiting from WBT in several
ways:
❑ Eliminating time away from the workplace.
❑ Accessing training at convenient times, locations, and
individual paces.
❑ Bolstering student confidence in Internet-based training and
increasing the likelihood of participating in additional WBT
training sessions.

Here you will find both Moldflow courses and courses from our
education partner, Nypro Institute. Courses cover the latest
releases of Moldflow products, including Moldflow Plastics
Insight (MPI) 3.0 and Moldflow Mold Adviser, as well as several
general courses on injection molding, materials and mold design.
These Web-based courses provide Moldflow customers with a
wealth of plastics industry information.
Moldflow's Web-based training provides the ideal foundation for
a blended training approach, complementing our traditional
training courses with the power and immediacy of online
technology. This results in learning programs that provide
increased retention and greater effectiveness.

Oftentimes, a training course cannot be scheduled to meet
everyone's individual or departmental needs. In a manufacturing
setting, for instance, people who work in around-the-clock shifts
often can only be removed from the line individually or in small
groups. Web-based courses are an effective tool that can be used
throughout a workday to train individuals without disrupting the
production line. Unlike an instructor-led course, Web-based
courses can be used at any time, in any place a computer is
available.
For more information about Moldflow's Web-based training
courses and other education services, please visit the Education
Zone at www.plasticszone.com.

Moldflow's Web-based training courses are available through the
Education Zone at www.plasticszone.com.
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real world success
Swift Technologies Applies Moldflow
Plastics Advisers to Every Job
By Laura Carrabine, Editor
Swift Technologies Limited, a Cambridgeshire, England-based
materials technology company, provides the manufacturing
industry with unique solutions to traditional problems. The
company's Swiftool Rapid Manufacturing System aids in quickly
and economically producing plastic or polymer moldings. The
technology is based on a smart polymeric tooling medium that
facilitates the blending of materials and manufacture of mold tools
on site. The process involves application of pressure and vacuum
to the Swiftool composite via purpose designed vacuum presses.
Swift Technologies' equipment varies in size from presses as small
as a household refrigerator to as large as a commercial truck. Paul
Shepheard is the company's technical director. He says Swift
Technologies' (Swiftech) reason for doing business is to provide
tools as fast as possible.
"Traditionally, injection mold tools can take anywhere from one
week to 16 weeks to manufacture," says Shepheard. "At Swiftech,
we can fulfill orders in between one to 16 days. We are much
faster. How? Our tooling system fast tracks the tool making
process." Engineers and designers are also finding better ways of
doing their jobs, such as initiating very sound proactive practices
at the early stages of each job, including the use of Moldflow Part
Adviser and Moldflow Mold Adviser software from Moldflow
Corporation.
Swiftech operates two business models. One is designing and
marketing systems that enable molders to make injection mold
tools very quickly. The other side of the business is using its own
equipment to make tools to generate customers' parts quickly.
"Obviously," adds Shepheard, "we wouldn't be able to make the
parts if we didn't have the tools. We are in a unique position in
that we have all the equipment. When customers send us a 3D file,
we are usually able to make those parts within a couple days by
first making the tool and then making the parts."
However, in the first year of work, Shepheard and his colleagues
found that their customers' designs were presenting them with
production difficulties. "They didn't mean to," notes Shepheard.
"Unknowingly, they sent us part files that couldn't be
manufactured, and we didn't know it because we didn't design the
parts. Back then, we went through our normal process. We'd make
a tool and learn too late that the tool wouldn't satisfactorily make
the part. That's when we investigated Moldflow software. We
couldn't afford to stay on the same costly path we were going
down at the time."
Now Shepheard's team uses Moldflow software on every single file
that they receive. "Using Moldflow is an integral part of our
procedures," says Shepheard. Swiftech operations can perform up
to 20 Moldflow analyses per day. "Using Moldflow is part of our
proactive strategy to make sure that the part can actually be made.
We don't even charge for running the simulations."
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When a file comes through that shows design flaws, Swiftech
returns the file for customer redesign or for assistance from
Shepheard and his team. Customers quickly learn that their
designs are not manufacturable early in the design process versus
later on when the tools have been machined and unable to
produce parts. "It doesn't happen often," notes Shepheard, "but at
least once or twice per week, we receive a file that we can't work
with."
He says another reason for using Moldflow on every single job is
for credibility. "Manufacturers have been making steel tools for
years and years," says Shepheard. "There are no questions about
integrity or quality, because people are used to tools being made
out of steel. However, with a new process like ours, when we
turned jobs around and told customers that we couldn't make
their parts, the customer started to question our expertise. So, we
invested in Moldflow to be able to show credible evidence that
many issues are not our problems, but rather the customer's.
Moldflow brings us confidence, credibility, and peace of mind."

Software benefits
Shepheard says that using Moldflow allows his team to locate
design errors very quickly. "We didn't want to waste valuable time
manufacturing something that couldn't generate parts," adds
Shepheard. "The software automatically gives us the best injection
point and gate location. That was an absolute godsend to us
because now, for every single job, we know for sure that all gates
are located in the optimized positions. Those two factors are the
most important in our workflow."
"It works well for our customers, too. They know that we apply
best practices to help them achieve their goal — obtaining parts.
In the rare instances in which we fail, at least the failure arises
before steel has been cut — before the cost of the mistake can cost
customers five to ten times more than the actual job and take 10
times longer. Moldflow allows us to interact with the design much
earlier, and if, there is a problem for whatever reason, now is the
time to do something about it."
Shepheard says that Moldflow has changed the way Swiftech does
business. If the software didn't exist, Swiftech would not exist or
would be a significantly different organization. "The software has
had that big of an effect on the way we do business," notes
Shepheard.
Since investing in the software and hardware to run it, Shepheard
says the company has recouped its ROI many times over. "We've
made about 400 tools now as a result of using Moldflow over the
last two years. We have made many more tools than could hope to
be achieved by a conventional toolmaker of comparable size and
Moldflow has played a major part in our success," adds Shepheard.
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Swiftech operators can simultaneously run approximately 12
customer file simulations. Files are downloaded as STL, IGES, or
native CAD formats. The process uses STL files in two ways —
one for Moldflow simulations and one for making patterns for
generating tools. Shepheard says, "When a customer sends a part
file, we run the Moldflow analysis on it. If it's okay, we build the
part using stereolithography equipment to make a pattern. We
then fabricate the tool around the pattern."
When it came time for Swiftech to investigate plastic simulation
software, Shepheard did some research on the Internet. "Moldflow
has an excellent reputation in this arena," notes Shepheard. "We
were overwhelmed by the level of confidence that we heard from
colleagues who were using the technology. Soon after, we saw a
demonstration of the products and became a customer." That was
two years ago.

Learning curve
Shepheard says that to really become proficient using the software
takes about four weeks. "For many other software packages,
training and proficiency take upward of 12 to 16 weeks," adds
Shepheard. "Moldflow Part Adviser and Moldflow Mold Adviser
are so simple to understand. While the packages are sophisticated
software, they are at the same time easy to learn and easy to use."
Several Swiftech engineers attended training at Moldflow's UKbased offices.
"Since we do run so many Moldflow analyses per day, we have
been able to build up a level of knowledge and understanding

about the software. We like that it works with precision and
reliability," adds Shepheard.
When Swiftech first installed the software, Shepheard and his
team tested the product by "feeding it" a design that had given
them problems in the past with regard to gate locations. "The
Moldflow analysis showed that we shouldn't have gated the part
the way we did. We were so pleased that the software investigated
precisely what didn't work. That gave us good feelings about how
it would treat files for us correctly in the future. That was a good
initial test. We knew we had struggled in the past with troubled
designs and experienced the headaches they cause internally.
Moldflow has helped eliminate all those long, arduous hours for
us."
For more information about Swift Technologies Limited, visit
www.swiftech.co.uk. For more information about Moldflow
Plastics Advisers (MPA) software, visit www.moldflow.com.

DO YOU HAVE A STORY TO TELL?
If so, we want to hear from you. To submit
articles, case studies, or user reviews of any
Moldflow technology, please contact Laura
Carrabine at laura_carrabine@moldflow.com
or call +1 440 247 8653.

the executive view

Working Smarter in a Tight Economy
By John McEleney, President and CEO, SolidWorks

John McEleney, president and CEO of
SolidWorks, offers some thoughts on
how businesses should perceive the
present economic situation and some
tips on weathering the storm.
First of all, get a sense of perspective.
The world is not ending. Workers and
management should take a deep
breath and realize that civilizations
have been around for millennia. Think
about it. We have endured centuries
filled with upheaval and new
discoveries. Be assured that there will
be a tomorrow and business will be
transacted. As soon as people rid
themselves of fear, the black cloud will
lift, and they will be in a much better
state to be productive.
Second, focus on fundamentals. When
times are good, companies try to
accomplish as much as possible.
However, when times are tough,
people
should
focus
on
the
fundamentals because they don't have
the extra cycles, extra capital, or the
extra personnel to achieve all that they
would like to do. In addition,
determine your company's raison
d'être. Ask, "What do we do well?"
and "What are customers willing to
pay for?" Regard this time as an
opportunity to refocus.
To do so, determine your competition's
position in the market space and what
you can do to gain a competitive
advantage. This is the point where you
need to tighten the belt one more
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notch and continue to make
investments, even when times are
tough. It's one sure way to gain the
competitive advantage. Because when
the economy begins to turn around,
companies will find themselves in one
of three scenarios: either having
gained
marketshare,
maintained
marketshare, or lost marketshare. I
think most people in these markets
hope to be able to maintain
marketshare. That's the wrong
mentality. Companies must regard this
time as an opportunity to gain a
competitive edge. Be aggressive, even
now, to do whatever it takes to remain
a winner. Take advantage of the
opportunities that change creates.
Third, set priorities. In the book The 7
Habits of Highly Effective People,
author Stephen R. Covey talks about
urgent versus important. In times like
today, I think prioritization is
important. Determine what efforts are
urgent and which ones are important.
Then, structure your thought processes
and work activities to address the
important issues that are urgent.
Fourth, use this lull in the action to
educate yourself and update your
workplace. If your operation is using
dated technology, study up on what's
offered today and what best suits
your needs. Invest and train your staff
so that when the economy turns
around, you will be in a much more
competitive
position
to
gain
additional marketshare.
Case in point: Recently while on
vacation, I met a longtime AutoCAD
user. Ironically, his company recently
purchased some SolidWorks seats. He
told me that the younger users relished
the new technology and migrated to it
with gusto. However, the older users
were using the traditional 2D CAD
system and methodologies as a crutch.
With business a little slow, we both
agreed that this was a terrific
opportunity for him to force the

change-resistant users to improve their
skill sets. Undoubtedly, this is the time
to implement new technology and
conduct training so that when events
do turn around, companies will be in a
competitive position and much
stronger.
Technology providers today are
focusing greater energy on forming
collaborative partnerships, both for
delivering the latest advancements
efficiently to end users and promoting
technology education. For example,
Solidworks
works
closely
with
Moldflow to deliver integrated
solutions for the injection molding
plastics industry. Further, Web-based
options abound, make it easier to
acquire new technologies and the
training necessary to use them to their
fullest potential.
A few years down the road, when
we look back, I bet the winners out
of this recession are going to be
companies that went the extra mile,
made sound investments in people
and technology, and updated their
product development environments.
Companies that take these bold
initiatives will reap tremendous
rewards.
Lastly, maintain a sense of optimism.
The world is getting bigger every day
and it will continue to need
technology. Tomorrow someone will
launch a new innovation, a new
product, a new service, or new
technology that will allow us all to be
more efficient. There is always going to
be that next level of innovation. Let me
remind you that in the late 1800s, some
folks wanted to close the US Patent
Office because they thought that
everything that could be invented had
been. They were so wrong.
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The Benefits of Process
Monitoring in the
Real World
By Peter Rucinski, Moldflow Corporation

You cannot manage what you cannot
measure. These words ring true for all
types of companies across all types of
industries. Imagine a gas station that
was not measuring and tracking the
amount of gasoline it distributed, or an
energy company that was not
monitoring the amount of energy
produced
versus
consumer
requirements, or a soft drink producer
that did not measure how long it takes to
fill and package 500,000 bottles of its
product. These companies would have
no idea of when they were going to run
out of gasoline, energy, or soft drink.
Beyond that, they would not be able to
manage and grow their respective
companies because they were not
measuring key performance indicators
that are fundamental to their business
operations. Although it is hard to
believe, today there are multitudes of
companies that do not measure key
business performance indicators, and the
price they pay is lost market
opportunity, labor productivity losses,
and costs associated with manufacturing
inefficiencies
and
unscheduled
production downtime.
Not so for one innovative US-based
injection molder, Vision Plastics, who
uses the Moldflow Shotscope® process monitoring and analysis
system to measure and track key injection molding parameters,
allowing employees to work smarter and more productively and
give their company a strategic competitive advantage. The
Moldflow Shotscope process monitoring and analysis system is a
comprehensive product suite which collects critical data in real
time injection molding machines on the factory floor, then
records, analyzes, reports, and allows access to the information for
use in critical decision making. This article discusses how Vision
Plastics has implemented Moldflow's Shotscope system to
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monitor its injection molding process and the value derived from
measuring what it has to manage in order to control and grow its
business.

Eliminating Guesswork and Downtime
with Shotscope
Vision Plastics, Inc. started out in 1988 in Tualatin, Oregon, USA
with five molding presses and five employees. Today, the company
is relocated in a modern facility in Wilsonville, OR that houses
more than 38 machines and 150 employees. Vision Plastics is ISO
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9002 certified and one of the most highly regarded custom
injection molding companies in the Pacific Northwest.
Today, Vision Plastics utilizes the Shotscope process monitoring
and analysis system from Moldflow to assure that the very best
parts are being manufactured. This system, installed directly on
each molding machine, is a real-time program designed to capture
a picture of each injection shot through predetermined
parameters. The data collected is available for review through a
number of display screens. Shotscope provides shot profiles,
statistical process control trend charts, shot-to-shot comparisons,
and a number of other displays. Each molding press is equipped
with an analyzer to capture the data and with a remote screen to
display that data.
Each injection molding job has a set of predetermined parameters
that are input into the Shotscope system. Should any of the
parameters move outside the control limits, the machine alarms
and highlights the discrepancy for immediate appropriate action
by the mold technician.
Any changes to the established molding processes that might be
necessary are well documented through a Cause and Effect system.
This closed-loop system identifies the root cause of any
discrepancies in the process and documents changes that are made
to the injection molding machine settings to bring the operation
back within the pre-set limits.
Mike Olson is Vision Plastics' Shotscope coordinator. It's his job
to keep all 26 Shotscope-based plastic injection molding machines
running at peak performance. "Shotscope generates profiles or
overlays of what the machine is doing internally at all times," says
Olson. "I save the overlays as references and as historical data. I
can pull any overlay up at any time and lay it on top of another to
see if there is any variation in the process. The overlays tell us if the
machine is varying from shot to shot, showing inconsistency."

get the system up and running at Vision and we have been using
it ever since to its full potential." Shotscope monitors 26
machines, although the software can monitor up to 32 machines
at once. Olson installed the Windows version of the software in
August of 1997.

Shotscope Benefits
The software provides a graphical overview of the Vision Plastics
shop floor. Different colored icons depicts each machine. Gray
icons depict machines with no communication between the
machine and Shotscope. If the machine is not running, then the
icon is red. A yellow icon represents an operating machine that has
exceeded one or more parameters. "Yellow signals me to
investigate what is causing the machine to go beyond our set
parameters," says Olson. A green icon indicates a machine that is
running within all parameters.

"We used Shotscope at my previous place of
employment and the software was considered a
valuable tool. I volunteered to get the system up
and running at Vision and we have been using it
ever since to its full potential," said Olson.
When Olson first joined Vision Plastics several years ago, the
company was not actively using Shotscope. "We used it once or
twice but that was only because one particular customer wanted
cavity pressure and mold temperatures from every shot. Once we
made the run, we downloaded the data to a diskette and sent it to
them with the parts. At that time, that was the extent of Shotscope
use here."
At that time, Olson approached the company owner to find out
why. "We used Shotscope at my previous place of employment
and the software was considered a valuable tool. I volunteered to
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"Anytime something goes wrong, I can
quickly single out which machine needs
attention," adds Olson. "Usually a quick
adjustment or two is all that is needed and
we are back in business. Shotscope saves a
tremendous amount of time. Traditionally, it
would take several technicians and a lot of
time on the shop floor trying to figure out
the problem and how to remedy the
situation. Shotscope eliminates all that
guesswork and down time."

Recently, Moldflow engineers from the company's Oregon and
Australia-based offices visited Olson. I gave them a tour of the
facility and showed them how I use Shotscope. I made some
suggestions as to what I would like to see added to the next version
of the software such as pop up windows that give the user
information about what the machine is doing. They seemed very
pleased with the recommendations that we provided," says Olson.
During the visit with Moldflow, a Vision Plastics technician made
an adjustment to one of the molding machines without confiding
with Olson or Shotscope. The adjustment caused a yellow icon to
appear on Olson's monitor, indicating the highlighted machine's
w w w. m o l d f l o w. c o m
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process had been changed. Overlays were created to show before
and after process profiles. Upon comparison, it was clear that the
new process would cause an unstable process from shot to shot —
an out-of-control condition and questionable parts. The
information proved that the technician did not use Shotscope in
his decision making. The process was subsequently re-adjusted
and the machine was brought back into a controlled condition.

Shotscope profile
analysis revealed that
the press was fighting
to hit the transfer
position, resulting in
inconsistent fill time
and hold time from
shot to shot.

Three overlays originate from a linear transducer that measures
the positioning and velocity of the screw. A pressure transducer
provides pressure overlays. These profiles can be downloaded just
seconds after the machine completes a shot and Shotscope
analyzes the data. "After a few shots, I know pretty much what is
going on with each machine's process. Whereas, out on the floor,
it would take me 20-30 minutes to gather the same data," Olson
says.

After the shot size
was decreased, a
stable process was
achieved.

It can be busy at times. However, Olson says that once he and the
technicians start the machine and a stable process is established,
his work is nearly complete for the whole run of each particular
machine. He adds, "If a heater band goes out, Shotscope will alert
me now before we start producing rejects. I can keep my limits so
tight that if the size of a part changes as minutely as 1/1,000 of an
inch, I will know about it. Or, if I lose temperature, Shotscope
highlights it and we can address the issue then, not when the
machine stops making parts, or when it starts making burned
parts, or when one of the zones overheats. Shotscope keeps a close
eye on all those areas that could become potential problems.”

Shotscope results
showed that the press
was not holding a
steady cushion length.
Upon investigation,
it was discovered that
the machine's check
rings needed to be
replaced.

"In this competitive market, Shotscope is invaluable. It helps
Vision Plastics remain a viable contender in the industry as a
leading producer of high quality parts," Olson explains.

Conclusion
You cannot manage what you cannot measure. These words ring
especially true for injection molder Vision Plastics, who relies on
Moldflow's Shotscope system to measure and track key business
performance indicators so that they can control and grow their
business profitably and with a significant competitive advantage.

After check ring
replacement,
Shotscope verified
that the machine
performed as
expected.

To learn more about Moldflow's Shotscope product, visit
www.moldflow.com. To learn more about Vision Plastics, visit
www.visionplastics.com

Visit the Education Zone to ...
... Get Moldflow Software Training!
... Get Moldflow Software User Certification!
... Participate in a Moldflow Web Seminar!

www. plasticszone.com
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T H E R E A R E B E T T E R WAYS TO CO L L E C T D ATA
F R O M YO U R I N J E C T I O N M O L D I N G M AC H I N E !
Do you know what job your machine is currently running? Is it running that job at its peak efficiency?
What are the optimal settings on this machine for this specific job? This is information you need to know
when producing your parts, but you don’t have to carry that burden on your back!
Moldflow Manufacturing Solutions products can answer all of these questions for you. Whether you are a small,
custom injection molder or a large multi-national corporation, our products will enable you to:
❒
❒
❒
❒
❒

Collect critical data in real time from the injection molding machines on the factory floor
Analyze process and production data and access real time reports
Improve molded part quality and labor productivity
Access plant-wide production information from anywhere in the world
Automate the process of scientific molding to decrease mold set up time, cycle time and scrap

Let Moldflow Manufacturing Solutions take the weight off you. To find out more, contact us or go to our Web site at
www.moldflow.com to download our new Manufacturing Solutions white paper.
Moldflow Corporation

C O R P O R A T I O N

430 Boston Post Road • Wayland, MA 01778
Tel +1 508 358 5848 • Fax +1 508 358 5868
www.moldflow.com

the polymer pages
CRIMS, the Benchmark Standard for
Shrinkage Prediction
A. Roland Thomas, Moldflow Corporation
"As far as the laws of mathematics refer to reality, they are not
certain, and as far as they are certain, they do not refer to reality."
Albert Einstein (1879-1955)
On the surface, this may appear a strange way to begin a
discussion about a predictive capability that relies heavily on
mathematics for its success. However the perspective it brings
captures the essence of modeling such a complex physical
behavior. In cases, such as the modeling of shrinkage, the general
theory accurately captures the basic behavior and trends. However,
the results are more useful if they can be made far more specific.
CRIMS (Corrected Residual In-Mold Stress) is a hybrid modeling
technique that augments the mathematical theory used to predict
shrinkage in injection molded parts. It works by comparing this
general model to real molded samples and creating a function to
minimize the difference. This function and its coefficients then
become part of the predictive model when used for real
applications.
The benefits of using CRIMS are too compelling to ignore.
Moldflow analyzed nearly 20,000 moldings, each with varied
process conditions, thickness, or material. The purpose was to
compare the accuracy of predictions based on mathematical
theory alone and those based on CRIMS. Greater than 85 percent
of the predictions based on CRIMS were within 20 percent of the
experimental result, whereas for the prediction based on
mathematical theory alone, less than 15 percent of achieved this
result.

Shrinkage background
As a brief introduction, Moldflow's approach to modeling
shrinkage starts from the basic drivers for the phenomena. A
model based on mathematical theory is used to simulate those
drivers, which in turn is compared to the result of experimental
observation and corrected to ensure that the model predicts what
really occurs.
Volumetric Shrinkage

Mold Restraint

Free

Free

Fixed

Fixed

Free

Figure 1

Free

Figure 2

When shrinkage occurs in an unconstrained and undeformed
material, the material attempts to shrink equally in all directions
(isotropically) as shown in Figure 1. The shrinkage itself is caused
by the change in state of the material from a molten, high
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Inside the mold, the mold and its features resist this shrinkage,
which in realistic moldings constrains all shrinkage to the
dimensions of the mold with the exception of shrinkage across the
thickness, where the material is free to move (Figure 2). Therefore,
if the change of state requires that a certain volumetric change
occur yet that change is resisted, a stress is built up in the material,
which in turn begins to be relieved while the part cools in the
mold.
When the part is ejected from the mold, the constraint is removed
and the remaining stresses cause a change of shape in the part that
we know as shrinkage. Subsequent cooling will also cause thermal
contraction and more shrinkage.
There are other issues such as variations in crystallinity and the
stresses due to the orientation of molecules and fibers that I will
not address here. For further information, please see the references
at the end of this article.
The steps to solve this are:
1. Calculate the residual stress while the material is in the mold
using the calculated pressure-temperature history.
2. Using the residual stress, calculate the initial shrinkage at
ejection.
3. Calculate additional shrinkage while the part cools to room
temperature.
This is a general model called the residual stress model. The steps
are straightforward to describe. However, this is an example of
where the direct implementation of the mathematical model will
result in a model that predicts the trends but does not describe
reality with sufficient precision.

CRIMS

Free

Free

pressure/high temperature state, as exists inside a mold, to a solid,
low pressure/low temperature state, as exists at atmospheric
conditions. For semi-crystalline materials, this change in state
includes the crystallization process.

In order to calculate residual stress, a viscoelastic model with
suitable material data over the range of conditions encountered in
injection molding is required. In view of the temperature range in
injection molding, such a model must be valid in the melt state,
during the phase change, and in the solid state. At this time no
suitable theoretical models are available. In order to make progress
in simulation, some simplification is required. This simplification
introduces errors that can make predictions from the simplified
theoretical model too inaccurate for use.
The solution to this problem is the CRIMS model. This is a
hybrid model that utilizes measured shrinkage data to improve the
prediction of shrinkage and warpage from theoretical models such
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as previously described. By comparing theoretical model
predictions to experimentally measured shrinkages on molded
samples, the CRIMS technique creates a function to minimize the
error. The coefficients of this function are the "CRIMS
coefficients" and are stored in the Moldflow Material Database.
When users perform perform shrinkage and warpage predictions
on their parts, these coefficients are used to correct the calculated
residual streseses and so minimize the error introduced by using a
simplified model.
The CRIMS method may be used for filled and unfilled materials
and also performs well for polymer blends. It allows us to
overcome the inaccuracy inherent in simplified models while
retaining the ability of these models to follow trends. It also
enables predictions using conditions outside the range of
measurement of the samples used to obtain the coefficients.

Figure 4. Measured Parallel and Perpendicular Shrinkage

The instrumented experimental mold is shown in Figure 3.
Shrinkage values are measured both along and across the direction
of flow under a variety of thicknesses and molding conditions.
Figure 4 shows the measured results obtained for an unfilled
polypropylene. The anisotropy in shrinkage between the flow and
cross-flow directions is evident. Figures 5 and 6 each show
experimental results, the mathematical theory result, and the
CRIMS result for shrinkage in the flow and cross-flow directions,
respectively. The improvement in the prediction is dramatic.
Moldflow supplies its mathematical model in both a CRIMS form
and in a form that does not use measured values. The latter is
useful for showing trends, for example, how a change in processing
conditions would affect shrinkage, and allows predictions using
the over 7000 grades of thermoplastics in the Moldflow Material
Database.
For more information we recommend the articles and books listed
on the following page.
For information on the Moldflow Material Database, CRIMS
shrinkage modeling, or comprehensive material testing services,
contact Moldflow Plastics Labs at mpl@moldflow.com.

Figure 5. Measured and Calculated Shrinkages in the
Flow Direction

Figure 3. Diagram of Molded
Shrinkage Sample
Figure 6. Measured and Calculated Shrinkages in the
Cross-Flow Direction
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learning curves
Penn State Erie: Teaching the Plastic
Industry's "Impact Players" of Tomorrow
By Laura Carrabine, Editor

Emphasis on CAE
Students who opt for the Technology Accreditation Commission
of the Accreditation Board for Engineering and Technology
(TAC/ABET)-accredited plastics engineering technology (PLET)
program at Penn State Erie, The Behrend College, get education
and training that make them "Impact Players" in the plastics
industry, says John P. Beaumont, their professor, department chair,
and a former technical manager at Moldflow. With the program's
unique integration of computer-aided engineering (CAE)
programs into courses from the sophomore year forward, Penn
State Erie's PLET graduates are exceptionally well prepared to
compete in the plastics industry.
"I came to Penn State Erie with a mandate to develop the newest
technology in the plastics industry and teach our PLET students
how to use it," said Beaumont. "CAE is a continually evolving
technology, and since the program's inception we've made it part
of our students' daily classroom experience."
"CAE is an accelerated learning tool, sort of like an X-ray that
gives you insight into how a plastics mold should be made to
produce successful plastic parts," said Beaumont. "A mold can
cost a quarter-million dollars or more, so anything that ensures it's
properly made saves time and money. We want Penn State Erie's
PLET graduates to be able to use CAE for just those reasons."
However, according to Beaumont, just as an X-ray needs a doctor
to interpret results, CAE needs someone skilled to interpret
analysis results. Therefore, Beaumont and his colleagues require all
students to complete industry-like projects using mold filling,
cooling, shrinkage, and warpage analyses in both mold and
product design courses.
PLET majors begin their computer foundation in the freshman
year with solids modeling using Pro/ENGINEER®. In their
sophomore year they begin to use mold filling simulation in the
plastics processing courses to better understand what occurs
during molding. In the first semester of their junior year, students
begin a progression of design courses that deeply involve them in
CAE technologies. During the junior year, they work with
Moldflow's mold filling, cooling, shrinkage, and warpage
programs as part of mold and plastic part design classes. In
addition to the details of modeling, studies at this level emphasize
interpretation and practical application of CAE technologies.
Further courses focus on structural analysis using ANSYS®
software and thin-shell modeling and meshing using
Pro/ENGINEER software for plastics applications. During their
senior year, students continue to learn and apply CAE
technologies in both required and elective courses. Throughout
this process, the faculty requires students to link their knowledge
of plastic materials, processing, mold design, and part design;
CAE technologies provide an efficient tool to connect all four of
these areas.
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Penn State Erie's PLET
program has grown to
include four engineering
computer labs with more
than 100 networked
computers running the
latest releases of CAE
software. Over the years,
instructors have evaluated
a variety of CAE
programs, but they have
always featured Moldflow
software, because of its
quality and US-based
support structure. As a
Students utilizing Moldflow software
result, Moldflow employs
in the engineering computer lab as
a significant number of
part of their course work at Penn
Penn State Erie graduates
State Erie.
because of their solid
understanding of the applications.
In addition to the four
PLET computer labs,
the R.J. Fasenmyer
Building
in
the
engineering complex
houses a plastics
processing laboratory
outfitted by industry
with the most up-todate equipment. The
lab, a 180-foot-long,
two-story, high-bay
structure with a fiveton overhead bridge
crane, is equipped with
conventional
Overhead shot of plastics processing lab in hydraulic,
fully
the R.J. Fasenmyer Building at Penn
electric, and hybrid
State Erie.
processing machines.
Adjacent
to
the
processing laboratory are three labs for water treatment, plastics
quality control, and rapid prototyping.

Student Opportunities
Since the beginning of the PLET program, Beaumont and other
faculty have taken their students to the Society of Plastics
Engineers Annual Technical Conference (ANTEC) each Spring.
In 1989, Penn State Erie presented three of the 11 student papers
at ANTEC; in 1996, they presented 20 of 28 papers. In 2001,
faculty escorted 59 students to ANTEC, where 27 papers were
presented and six won Best Paper Award in their student divisions.
w w w. m o l d f l o w. c o m
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"The ANTEC opportunities provide unique experiences for the
students," said Beaumont. "They learn to organize their thoughts
and go before a professional audience to defend their work. Once
they do it, they've taken a major step toward proficiency and
maturity. The experience helps build confidence and public
speaking skills."

colleagues responded as consultants to the industry's request for
help. The PTC also provided a mechanism to get students
involved with real industry problems, and this remains a primary
objective of faculty outreach activities. In a very short time, the
demand outgrew faculty time to respond, so they first hired a staff
assistant, then hired their graduates as engineers. One of the first
to join the PTC was Jon Meckley, a former student who, after
working for several years with the PTC and as a consultant,
returned to the PLET program as a faculty member. Today a
number of former students currently work for the PTC.
Six years ago, Jon began to experiment with CAE applications in
blow molding, the plastics technology used for molding hollow
parts. Out of his work grew the Blow Molding Consortium,
which serves the growing sector of the industry that uses this
technology. The college, with the support of industry and grants
from the National Science Foundation, the PTC, and the Ben
Franklin Partnership, was able to acquire three blow-molding
machines, several molds, and blow molding simulation software.
Today, several regional plastics companies are members of the
consortium and receive support in the areas of training, product
and process development, equipment selection, and process
optimization.

History

PLET majors traveled to China in 1997 to attend the Chinaplas
show in Shanghai.
One aspect of the PLET program that helps to make Penn State
Erie's students "Impact Players" is the opportunity for
international travel. Each year, faculty and upper-class PLET
majors attend an international plastics show outside the US. "New
technologies are showcased every year at international trade
shows," Beaumont said. "In addition to giving our students
international competency — how to travel, eat, and live outside
the American culture — we want them to see what's the latest and
greatest. We live in an international economy, and there is no
doubt we will continue to exchange technologies and products
around the globe."

Applied Research Centers Make Industry
Connection
One beneficial result of Penn State Erie's PLET program has been
the several outreach centers that resulted from the industry
orientation of the program. The first, the Plastics Technology
Center (PTC), originated in 1989 when Beaumont and his
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The concept of Penn State Erie's plastics program originated in
the early 1980s, when a group of local plastics manufacturing
CEOs, including Hoop Roche from Erie Plastics, Joe Prischak
from Plastek, and Bill Witkowski from Port Erie Plastics, asked
the School of Engineering and Engineering Technology at Penn
State Erie to consider developing a plastics engineering technology
program that would improve and advance the skill base of their
employees. The college agreed, and by 1989 had a core group of
three faculty, Robert Farrell, Paul Koch, and Beaumont, to get the
program under way. Before coming to Erie, Farrell, a mechanical
engineer, was vice-president of engineering at Reed Machine, and
Koch, a chemical engineer, was program manager for Avery
International, Fasson Division. Beaumont was employed as the
technical manager for Moldflow in Kalamazoo, Michigan.
Today, the PLET program enrolls more than 250 students. New
faculty-educators who average more than 10 years of industry
experience-add practical knowledge to their teaching and industry
outreach. Together, the great faculty and the engineering staff of
the PTC give the PLET program a total of more than 50 years'
experience in the application of CAE technologies. By hiring new
faculty with expertise in materials and processing, and by
nurturing its strong ties with the plastics industry, Penn State Erie
has built one of the strongest CAE educational centers in the
world.
For more information about Penn State Erie's PLET program,
contact Loretta Brandon in the Office of University Affairs
(tel: +1 814 898 6063, email: lzb6@psu.edu) or visit
http://engr.bd.psu.edu/degrees/plet.html.
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design & molding
Medical Device Design Challenges
By Len Czuba, President, Czuba Enterprises, Inc.
Medical device
developers are
rapidly realizing
the benefits and
challenges
of
using CAD and
manufacturing
tools,
rapid
prototyping
services, mold
design and support services, and new Webbased product development resources.
Speed-to-market was the mantra in the
1990s and with the growth of — or rather
the "shrinking of" — computerization,
more features can be built into nextgeneration products.

High Tech but Easy-to-use
I believe that in spite of all the hype about
speed and power and the ability to do
things better than ever before, we must
consider other factors. The bottom line is
the ability to create a product that can and
will be used in a way that avoids setup
problems and mistakes in usage in the field,
and offers intuitive simplicity. Medical
devices provide life-saving therapies if used
properly. They are used in several settings;
emergency rooms, during critical surgery,
and in the delivery of medication. Any
mistakes in setup, use, or function of the
device can put the life of the patient at risk.
Fail-safe systems are not really fail-safe, as
has been repeatedly shown in reports of
user-caused errors.
Medical device designers are faced with
tough challenges, especially since regulatory
agencies worldwide are mandating fail-safe
products. It is the responsibility of the
product designer and engineer to create the
product in a way that will meet the needs of
the user as efficiently as possible while not
compromising the wealth of features that
can be built into the product.

An Infusion Pump
Consider, for example, a new infusion
pump for IV drug delivery. The design
engineer must understand issues such as:
❑ What solutions or drugs will the
pump be used for?
❑ Will it be used for high volume or slow
infusion of low volumes?
❑ Are the drugs to be infused controlled
substances that need to be stored securely?
F l o w f r o n t Vo l . 2 I s s u e 1

❑ Who will use this pump - a trained
health care professional such as a nurse or
physician, or will it by used at home by
the patient or their family?
❑ Where will the pump be used - in the
emergency room, ambulance, intensive
care unit, on the hospital floor bedside or
at home, or will it be for the active
ambulatory patient?
❑ Will this product be used in developing
countries?
❑ What language or symbology will be
used?
❑ If the unit is in a harsh environment
what are the chances damage will be
incurred?
❑ How will maintenance be performed
and I.V. tubing and sets be changed?

A Clean Sheet of Paper
The designer starts with a clean sheet of
paper and initiates designs that meet the
physical and functional requirements of the
product. Considerations include the shape,
colors, controls, and interfaces that give the
product its unique characteristic that will
appeal to the user and enhance their ability
to do their job. Ease-of-use and reliability
separate the mundane products from the
great ones. The so-called plug-and-play
product will more quickly be accepted by
the user than one that requires extensive inservice training to be able to use it.

The Layout, Wall
Thickness, and Materials
Once the initial design layout is complete,
the mechanisms, boards, cabling, and
controls can be laid out more formally and
built into the design. CAD systems allow
rapid assessment of space utilization and
areas of interference. Proper material
selection can offer thinner wall sections,
longer runs, and greater resistance to
breakage with better impact resistance. By
using appealing, colored thermoplastic
elastomers (TPEs) in the housing, a
product can be given drop impact
protection and an enhanced appearance.
Color displays that have high resolution
and readability from wide angles and
distance add to the tendency of the product
to be used correctly. The science of human
factor interaction with the user interface
must be considered as new regulations
mandate systems that are designed to
prevent mistakes.

The manufacture of the product with a
good idea of annual volume requirements
must also be considered early in the design
of the product. This factor will dictate what
type of tooling will be built and used to
make the parts. If new software is
developed and used, it must be carefully
and extensively tested and validated.
Meanwhile, during all this development,
the regulatory requirements must be met.
Design controls requirements need the
attention of the design team throughout
the development program, not just when
the product is ready to be marketed. A
properly run development program will
support a filing to the FDA, for example,
and the filing will be tremendously easier.

Inside or Outsource
Product development programs of any size
can be maintained and managed internally
or by outsourcing some components of the
project. Depending on the talent and
resources on staff within an organization,
the decision can be made to use the internal
skill set or to rely on external experts. For
many companies, the use of outside
resources makes good business senseallowing the company to do what it does
well while outsourcing parts of the project
to outside pros. This collaborative effort
results in obtaining a better product, in less
time, and for less cost.
It is the ultimate responsibility of the
design engineer to develop the products
that customers need, as well as adhere to
the requirements set for that product.
Don't overlook the need for in-process
product reviews. Evaluate and test the
prototypes. Engage typical users with the
product in the early stages of the program.
The feedback from the non-informed,
eventual user can be sometimes more
insightful than a whole roomful of
engineers and designers. Consider the
product from cradle to grave. Throughout
the process, consider product lifecycle, as
well as disposability, waste disposal (are
batteries a disposable part of the product?)
and whether the device is recyclable.
Finally, it can be a challenge to develop a
new medical device given the current
engineering and regulatory environment.
But, if executed properly, the process can be
profitable, gratifying, and an enjoyable
occupation!
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what’s new
Moldflow Extends the Capabilities of
MPI/Gas in Moldflow Plastics Insight 3.0
By Dean Piepiora, Moldflow Corporation
For certain types of part geometry, the gas-assisted injection
molding process is a common alternative to conventional
injection molding. However, the level of processing complexity is
increased versus conventional injection molding due to the
injection of the gas within the polymer melt. Understanding and
predicting the behavior and flow of the gas within the polymer
melt is critical to achieving success in designing both parts and
molds for the gas-assist process. Through years of research and
industry alliances, Moldflow has developed an understanding of
not only the gas-assisted injection molding process, but also how
to accurately predict the flow behavior of both the polymer melt
and the injected gas. Furthermore, in Moldflow Plastics Insight™
3.0 (MPI™ 3.0), the capabilities of MPI/Gas have been
significantly extended (MPI/Gas is the MPI module for
simulating the gas-assist process). MPI/Gas now interfaces with
both MPI/Warp and MPI/Fiber to predict both the shrinkage and
warpage of gas-assisted injection molded parts, as well as to
predict the effects of fibers during the filling of the part and the
effect of the fibers on post-molding shrinkage and part warpage.
MPI/Gas recently introduced capabilities that benefit those who
need to optimize part and mold designs, as well as the gas-assisted
injection molding process itself.
The gas-assisted injection molding process has found a niche
among certain types of applications such as television cabinets,
automotive interior door handles, appliance parts, toys, and many
others. It is common knowledge that by using the gas-assist
process, it is possible to produce parts that are rigid, devoid of sink
marks, and have a lower tendency to warp. The gas-assist process
also has been proven to reduce material consumption, machine
clamp tonnage and cycle time. The gas-assist process is frequently
used to produce complex parts that consist of a combination of
thick and thin sections.

❑ Evaluating mold design options and their impact on gas
penetration.
❑ Determining the appropriate processing conditions for
producing acceptable quality parts, including the volume of
plastic to inject and the timing of the gas injection.

New MPI/Gas Analysis Capabilities
New with the release of MPI 3.0, the MPI/Gas analysis module
supports the simulation of shrinkage and warpage of a gas-assist
part through an interface to MPI/Warp. As a result, it is possible
to estimate the residual stresses in the gas-assist part and consider
the effects on part warpage. All things being equal, a gas-assist
molded part typically will be more structurally rigid versus the
same part made by the conventional injection molding process.
Part designers can now validate this in the early stages of part
design, where the cost of change is minimal and the impact of that
change is greatest.
Below is an example of an actual part produced by conventional
injection molding, which was found to have an unacceptable
amount of post-molding warpage. The same part was molded
using the gas-assist process in an attempt to reduce warpage to
within acceptable tolerances. The design was slightly modified to
add flow leaders, which served as the gas channels and which were
the primary source of gas coring.
The images that follow indicate the out-of-plane displacement
using conventional injection molding and gas-assisted injection
molding. It can be seen that the image on the left, produced by
conventional injection molding, has significant warpage, while the
image on the right, the gas-assist part, is relatively flat. The

Because the gas-assist process involves the dynamic interaction of
two rheologically dissimilar materials flowing within typically
complex mold cavities, the optimization of the part design, mold
design, and process conditions is, at best, extremely difficult.
Furthermore, even years of experience with conventional injection
molding are not sufficient to deal with the gas-assist process,
especially in designing the gas-channel network and optimizing
the processing window.
MPI/Gas is a powerful software tool that provides the know-how
to better understand the complexities of the gas-assisted injection
molding process. The knowledge gained from using MPI/Gas
typically equates to improved part and mold design and the
reduction or elimination of problems during the production of
gas-assist parts. The software assists part and mold designers in:
❑ Evaluating material selection for gas-assisted injection
molding part design.
❑ Optimizing the plastic part design to obtain the desired gas
penetration.
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bottom image displays the predicted penetration of the gas
channels, seen as an X across the surface of the part.
In MPI 3.0, MPI/Gas users can also benefit from a new interface
to MPI/Fiber, which allows for the accurate simulation of the gasassist molding process with fiber-filled plastics. Fibers such as glass
and carbon are often added to plastics to improve the structural
performance of the final molded parts. These parts are often larger
in nature and lend themselves to the gas-assisted injection
molding process to reduce wall thickness, part weight, warpage,
and cycle time. The complexities of injecting fiber-filled plastics
with gas can now be simulated in MPI 3.0 to help ensure that the
molded parts will be of acceptable quality.
In addition, MPI/Gas flow results can be used as an input to an
MPI/Cool analysis, allowing users to study the impact of a
cooling-line layout on gas penetration and cycle time. The
cooling-line layout can be modified to improve the overall cooling
of the part, as well as to promote gas penetration.
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Conclusion
Because of the inherent complexities of the gas-assisted injection
molding process, it is necessary for companies to understand the
behavior and flow of the gas within the polymer melt in order to
optimize part design, mold design, and the gas-assisted injection
molding process itself. The MPI/Gas module of the Moldflow
Plastics Insight product line provides the tools required to
accurately predict the behavior of both the gas and polymer within
the gas-assist process so that users can optimize their part and
mold designs with confidence. Furthermore, in MPI 3.0, the
capabilities of MF/Gas have been significantly extended. MPI/Gas
now interfaces with MPI/Warp to predict both the shrinkage and
warpage of gas-assisted injection molded parts, and with
MPI/Fiber to predict the effects of fibers on the filling of the part
and the effect of the fiber orientation on post-molding shrinkage
and part warpage.
For more information about Moldflow Plastics Insight
products, visit www.moldflow.com or contact your local
Moldflow representative

w w w. m o l d f l o w. c o m
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the analyst says

Managing Innovative Product
Development in Tough Economic Times
By Marc Halpern, Research Director, Gartner Group
Marc Halpern is an analyst for the
Gartner Group in New York.
In the current era of consumer-driven
markets, companies must improve
their ability to innovate. Yet, an
analysis of R&D spending data from
48 Fortune 500 companies shown on
the figure below, suggests that the
research and development capacity
of
corporations
is
declining. 1
Therefore, manufacturers
are
challenged
with
improving the efficiency of
R&D without negatively
impacting their ability to
innovate.
The bars on the figure
suggest that the cost of R&D
has been rapidly accelerating
from 1998 through 2000. Yet,
research and development
investment remains constant
at an average of six percent
of total revenues for these 48
manufacturers. Since these
corporations will probably
maintain the six percent level
of R&D spending while the
cost of R&D will continue to increase,
the net R&D capacity of manufacturers
will decline with increased pressure on
revenues in these difficult economic
times.
Businesses can increase their R&D
capacity through adoption of broadbased business imperatives that
eliminate waste and simultaneously
take
steps
to
improve
R&D
performance. Elimination of waste can
add financial and human resources that
can be applied to high priority R&D
initiatives. R&D capacity improves
when businesses apply the increased
resources to an R&D organization that
can perform better. Broad-based
business imperatives that cut waste
include
customer
retention,
elimination of unnecessary IT expense,
and Product Portfolio Management.
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Gartner estimates that it can cost up to
40 times more to attract a new
customer than to keep a current one.
So retaining just five percent more
customers can translate into savings of
25 percent to 55 percent in
profitability. Also, companies that
prioritize customer-service processes,
people, and technology will be better
positioned for the economic rebound
with more loyal customers.

When appropriate, companies should
seek opportunities to make IT
operations
more
efficient.
Opportunities include reducing the
diversity of desktop operating systems
and office applications, reducing the
number of levels of IT services to the
minimum
needed,
eliminating
unnecessary physical moves by
personnel, seeking ways to reduce
support costs for geographically
disperse users, and eliminating
unnecessary rollouts of software
updates. Gartner research indicates
that large enterprises with 10,000 users
or more can save in excess of $300 per
user per year, or $3 million.
Product Portfolio Management (PPM)
can improve time to completion of
R&D efforts by 40 percent according to
early adopters by establishing objective
and systematic methods to prioritize
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new product and program initiatives.
PPM incorporates financial tracking,
human
resources
management,
technical risk assessment, and market
opportunity to reach consensus on how
to work smarter and which tools to
invest in to attain that goal. Most
companies do not have this discipline.
Consequently, they rarely understand
how R&D dollars and time are being
spent. Successful companies focus their
efforts on the programs that
matter
without
compromising on the quality
of R&D conducted.
Further, Product Portfolio
Management should be
supported with project and
program
management
applications that assist in
the
management
of
development
efforts
involving multiple nested
projects.
Adopters
of
project management tools
with design collaboration
functionality report 20
percent to 30 percent
improvement in the time and cost to
complete
individual
projects.
Program management software
helps realize the time and cost
savings by enabling managers to
detect
and
resolve
resource
bottlenecks.
Companies must invest to achieve
Product
Portfolio
Management
benefits. Adopters report costs ranging
from $250,000 to $1 million over two
to 12 months to deploy a Product
Portfolio Management environment,
depending on the scope of the
implementation. Adopters must also
have
the
support
of
senior
management to establish and enforce
the new business processes and to
dedicate a team to execute the
deployment.
1 Raw data published by Technology Review.
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Bob “The Conqueror” Carson: Assembly machinery

Harry “Hercules” Adams: Ski equipment

Steve “Invincible” Thomas: Medical instruments
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